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'DAATASCAN PROFESSIONAL

INTRODUCTION

'DAATASCAN is the generic name for the range of image
Scanners and scanning software developed by P:

Marketing Ltd. This user manual describes the operation of the
DAATASCAN Professional 105 hand-held image scanner for the
Amiga.

DAATASCAN Professional enables graphics to be captured and

easily. It is possible 1o scan photos, drawings, newspaper
clippings, magazines, books, etc.

i use manusl descis thebasic concept,conrols and use
of the DAATASCAN Professional image scanner. It describes the
{eatures of the scanner 1 Gtal 0 anabla 0 nctallaton and

images in several resolutions. They can be scanned at 100, 200,
300 o loch, vih o Gualty of e scanned inage
increasing with greater resoluti

and white )
or the scanner can simulate grey shades by using dither pattems
for photographs.

Tha sl hows e e o these s o8 sl
Intertace hardware cartridge and pr
enmancamant ptons. A ractarguls porion f an e can
eanned win varaie widh and neigh seings. Tno canmed
image can be magnified and edited at pixel level. The scanned
n

the
size and shape of the final image. Images can be loaded and
saved to create a cip ar ibrary for use within DTP, Paint and
Word Processing applications.

Wo e suro tht you il enoy using the scarner andfnd et
45 a new dimension (o the graphic capabilies of your AMiga.
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1.0 PACKING LIST

Packing list

Disk contents.

‘The scanner package contains the folowing items :

1. Hand-held image scanner.
2 The hardware intarsce carticge.
3 Power supply

TASCAN Professional sotwae disk
5 e veer i

"
made before use.

1. DSscanPro
Drawer contaning e DAATASCAN prjecs and oo
2.0t
Workbanch trawer coiaining uifessuch s notepad, il
printe, etc.
3 Expansio

Workbench drawer into which you can place icons for
Cepansion dovcos (ueh 2 & v oy e you iy ad 10
your Amiga system.

Sys

ACLIcon is contained in this Workbench drawer to show that
Gl seton

e Worksench pretaences drawer cotins ool or

oy e Wonpanen por
st

‘The shellproject s a souped-up CLI window for
by

atthe keyboard,
rashcan

from disk.

Empty
‘An empty Workbench drawer, Can be used to save IFF files
from DAATASCAN into
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2.0 SETTING UP

The scanner uses an interface that plugs nto the paralel port of
the Amiga.

Fitting the power supply

WARNING :

"Tum the power to your computer system OFF before fiting the
scanner hardware.

DO NOT CONNECT OR DISCONNECT THE INTERFACE
WHILST THE POWER IS ON, OR DAMAGE MAY OCCUR TO
BOTH THE INTERFACE AND THE COMPUTER.

o upphy ottt coou sodng e
mslmclmns Plug the power supply unitnto a standard mains

ind connect the output plug into the corresponding
ookt on the metacs canion

Comnecting the Interace carrdge
s e ntrace connecing cable i theparale ot ocated
e roat of It g ameing s oy ushec
i o e vl resaron o 1 per S0y iy oo 0
nnect the parallel cable into the appropriate port on your
printer switch box.

Loading the softwar

Fig.1 DAATASCAN interface

8 pin mini
skt on th neface ensuring hat the pine align and tha the

on the scanner plug is facing downwards. This s a firm .,
S0 nsure that 11 pusned homo oy

Once the scanner hardware has been connected, switch on the
oL

The Workench (s beloaded o 1o DAKTASCAN dk
‘Once Workvench is loaded, open the DScanPro disk. The
Wokoaneh and DScanPrs rawarswil o depayes
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pen he DScanPro cawer o deplay o DAATASCAN fes
ouble-clck on the READ_ME project for any addifonal notes.

1y o tun e program rom ha ik, un the
Install_On_DHO project and the DAATASCAN fles will be
oo You v i B Ssanis o

 run
the DAATASCAN software.

Fig2 The opening screen

“This will then bring up the opening screen.
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3.0 SCANNING A DOCUMENT
How to scan an image
Now follows a simple outine procedure for scanning.

1 Set the length and width of the page on the Settings window.

Fig:3 The Setiings window
Whaning o b hld cannr s acdead oSt ot

o e moved over a distance o one page ongth eloe hs
foctoniscomplld Toset e lengh of 1 page cick o e
Height and Width boxes on the master page and ret

Tenhed 1208 orsoloc e ot s wo et page s A o
A5. Place the scanner at the top of the document or image to be.
scanned.

2 Ensure that the resolution switch on the scanner s set to the
same resolution (DP! sefting) as the software and select the
reen display will now change to the real-time
Scanner Display indicating that the software is ready to scan and
vl resouton th scan s 0 beperomed ar;dplaying
Real-time scan at

3 e green san gntn e unersde of e scanner wil gt
Align the scanner at the top of the document and
e he START o it s e scamr ot 1o tort

w.
the computer.
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Move tnescannorsowly and smootly down th document As
the image filsthe screen. the Reaktime dispiay wil wrap around
Uil e ot g hlgh s compioted e

Over”
indiato goes i duringscanning, asower scaming spesd
should be

 the scan has been completed the software leaves the
Do ime Searmer ey o and reme o e min
screen.

AL
sl

TN OEEE
T

Fig.4 The Image window

displayed in
ashort delay. The image may now be edited, printed, saved, efc.
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4.0 SCANNER CONTROLS

TEXT PHOTO

LIGHT DARK

external switches, and are described below.

Scan and dither switches
‘The controls on the hand scanner adjust the type of scan
performed. On the left side of the scanner are two controls. The
START button,which s used 1 sctale e scanar and show
to scan a doct

N i bt 1§ ihe Scan Modo swich whichcan b set
one of four positions.

The TEXT sefting results in scans n black and white mode (two
tone, for scanning ne art, charts, text, etc.). The other three

P
grey scales (naftones, fo scanning photos & colour pictures
etc).

Besciutin ant Efgimss cortive
On the right side of the scanner are two further controls. The
Resolution switch, which can be set to position 100, 200, 300 or
400, This sefting stands for the number of dols per inch th

the greater the size, density and qualty of the image.

The conalpostion
o e riness Comvol o 1+ e vt soing an
cortect for most purposes.




View window and Speed Ov
O ofthe seanrer & e viowing window which s urinated
when the scan button is pressed.

Co

Fig:5 Top view of hand scanner

Thereis analgnment arow on ofhersiceof the wndow wicn
allows the scanner to be accurately lined up before scanning.
Oriy ha mage batweon tho two algnment atows i be.
scanned.

Just below the viewing window is a smal red LED which is
known as a‘Speed Over'Indicator. This LED lights when the
scanning operation starts and flickers when the scanner is
moved at the optimum speed.

Wnen the LED goes ou itis an indication tha the scanner is
being moved 100 quickly and data is being lost. The START
button must be released and the LED will relight showing tis

gain:
Speed during the scanning operation.
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5.0 DAATASCAN SOFTWARE

Operations are performed by selection of menu options, icons or
keyboard shortcuts.

Fig.6 DAATASCAN opening screen

Settings window
‘The Setiings window contains information on scanner settings.
page area, memory usage, etc.

Fig.7 Settings window
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Type

Solcs e o ofpagesize, ok on ither AS 1 A4t slect
the required page size. The height and width adjust to the new.
dmensons.Ary image conla\nm n the Image window is lost
when selecting a now p:

Memory
Displays the amount of memory remaining in the computer
available for use.

Resolution

“The hand scanner has a 4 position switch which sefs the

resolution. Position 1 sets 100 dpi resolution whilt 2, 3 and 4 set
300 and 400 dpi respectively. The resoluton set by the

timing.

Scaling

‘Shows the units in which the widih, height and X offset ar
apayod . afer nces o millmatrs. The selected opion s

highiighted. Simply click on the required option to Select.

X offset
Displays the X offset which determines the scan position in the
Porizona et inrlation ot f acge of e page size
setin Type. I the page size is set at 8" wide then set

il ahabl scan'f e o sde f e page and a4 X Ofcet
will enable a scan of the right side of the page.

Width

page. To
click on box and retype the desired width

Height
Shows the height of the page. To set height for subsequent
Scans click on box and retype the desired height

Positioner
‘Shows current area displayed within the Image window in
prapton o e actuasizeof heimage Thesetn of e

1o mouse panter over the box and Graggng he box 1o h
e locaon. The mage window il tho b6 poaled.

ClosingtheSettings window
To close the s click on the ‘ciose box  in
et o comor ol me indow, Al othe windows can be
closed in the same way. Unlike other windows the Settings
window ey be recpened.
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Using the icons

Scan Clipboard

Scan Current Area

Resolution
[z
(]4]

On the left hand side of the screen are the icons for using the
am.

the icons and thelr functions.

FUNCTION

Load fl from disk.

Save image to disk as IFF f

Commence scan to Image window.

Commence scan to Clipboard area.

Commence scan to Current area.

‘Open Zoom window.

Printan IFF fl stored on disk.

Select scan resolution.
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‘The menu options.

Project menu

e icons only alow selecton of commonly used functions. The

from the desktop.

The Project menu options allow for file handiing when loading,
saving, deleting or printing an image to or from disk.

Fig:8 The Project menu

Conde' a oviously saved IFF i o memory.
Bings up he Fie Selector window and s i hefles i the
Cunent sk iractry. Stect e raciory (shown n Drawer) and

ick on the required file (shown in File) and select [OK] to 0ad.
Select [Cancel] 1o exit the File Selector window.

o IFF File
“This automaically saves the file under the default name. If the
file has not been previously saved selecting this opion brings up.

disk directory.
Selectihe dectory (shown i Drawer) and clck o th File box,
type in the flename and select [OK] to save. Select [Cancel]to
ext the File Selector window.

...
Brings up the File Selector window and and lists all th files in
the curent disk directory.
Solcth dirctry (shown nDrawer)an ik o ho il b,
type in the flename and select [OK] to save the image currently
261 witin ha mage window Seiet{Cancal 1ot v i
Seloctor window.

smvec

s Save As IFF File, except that the image saved s the.
-mage ety held Wit i Clpboard windom
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Image menu

Sy IM FleSoacor vindow and s s th hes n the
current dis

St o dvociory rown n Drawer) andcick o the fle
required (shown in Fie) and select [O)

St Cancelto e th Fis Sevtir window

print
Click on ‘Print and the image currently contained within the
scale of 1:1

images cannot bo prnted whilst the scanner is connected. The
interface cartridge must be disconnected from the paraliel
connector and the printer connected i s plac

Proferences
An option to allow you 10 set the maximum scan bufer size.
K8ytes for the-

use for scanning,

About
‘Shows detalls of the software including the latest version
number.

Fig:9 The ‘About Daatascan box

Quit
Exits the DAATASCAN program and returns to the Workbench

image that
foaded into memory and is contained within the Image window.
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Fig.10 The Image menu

Clear
Clears the Image window. Any image within the window is lost.

T cus  pre-defnedare o the mage 1 the it

First select the area to be cut by drawing a box around the.

roquied aree. Todo s simply ostion the mouse plner and
K and hold the left mouse button and when the pointer

oot NN wrow & & oo i & bk o e eroe

within the Image wind

Release the left mouse button to complete drawing the box.

image window.
‘The Ciipboard window opens; displaying the cut area.

Copy
Operates in the same way as the cut option, except that the area

i the image window intact,

Delete
Operatesn e same way as th utgpon, copt it e area
selected s permanently cut from the Image window. You

asked to confrm any deletions.

ste

Pasis thomagen e Clpboard nt theImage window.
lect ‘Paste’, then select either Normal (over-write) or

Yransnalenl aste fom he st ey hen postion he poiner
the Image window and press the left mouse button to paste.

crop
raw a box around the image required, drawing in the same way

asin the cut option.

Cropping the image will discard the area ouisi

and retain what i inside the box.

the crop box
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Clipboard menu

Invert
Inverts the Image window and produces a negative version of
Al black pixels change to white and vice versa

Settings
Re-opens the Settings window i it has been closed.

Zoom
Opans the Zoom window 10 aow you o view/et ths imaga in
ho Image window at pixe eve,at  magnifcation f .1
kg on e mage widow updtes s Zoum wnow o
display the current a

Piel o may be parformod witin the Zoom window

The Clpboard menu desl uthan mage ht hes been ut o
‘copied from the Image window into the Clipboar

Fig.11 The Clipboard menu

Clear

Clears the Clipboard. Any image within the window s ost.
otate 90

Allows the rotation of an image by 90 degroes in a clockwise

direction.

Flip Hori

Fis th Image on s horizontal
image of the original.

ds. This produces a mirror

Fite e image on its vertcal axis. This produces a mirror image.
of the original.

Invert

Inverts the image in the Clipboard and produces a negative

version of the image. All black pixels change to white and vice
rsa
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Scan menu

ens the zoom window t0 allow you to view/edit the image in
the Clipboard at pixel level, at a magnification of 8:1. Clicking on

area. Pixe eiting may be performed witin the Zoom window

memory in one of three scanning operations.

Fig 12 The Scan menu

To Image

settings on
the Image window. The screen clears and enters the real-ine
scanning mode allowing a scan to be performed. Once the scan

the Image window.

To Clipboard
Scanning can additonally be done into the Clipboard. The
clipboard must be opened before this takes place.

7y

i

Fig.13 Ciipboard

The scanning operation is performed in the same way as the
‘Scan To mage’ opration excep tat he scamed image wi
‘appear within the Clpboard window.

To Current.
“The third scanning opion is Scan To Gurrent Area. This wil
place the scanned image wihin the area that has been selected
within the Image window, using the 'rubber banding selection
method described in the ‘Cut section.
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Pixel editing

Fig 14 Current area

the Image window.

Facities e provided o adinga scarned image o s ool
n drawing on the Zoom window, cicking on a whit pixe!

Selocs crawig nack and i vrsn Pt aing 5

performed when you are in the zoom magnifcation mode.

Clicking on the zoom icon or selecting the zoom oplon from

either the Image or Clipboard menus wil open the Zoom window
tr the zoom magnifcation mod

In zo0m mode, the Zoom window displays the top left hand

comer of the image contained withi the Image or Clipboard

window at a scale factor of &:1.

Yaumay sorol e Zoam window a5 you woud any et

with the left mouse button. This will update the Zoom window
with the selected location.
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Fig.15 Zoom Mode

Pixel editing may be performed on efther the Image or Clipboard
window, depending upon which window is currently selected.

Keyboard shortcuts

keyboard shortcuts allow most of the operations to be
Camiod v vt i o ouee of i o e

KEY  ACTION

AL Load IFF File
AS ve IFF File

AW Save AsIFF File
AO  Save Clipboard

AE  Delet Fil

AP Pint

Ax

AC

AD  Delete

AV Paste (Norma))

AR rop

AG  Open Seftings

AZ  Zoomimage

Fi Scan To Im:

F2 Scan To Ciipboard

F3 Scan To Current Area
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APPENDIX A : TECHNICAL SPECIFICATIONS

Scanner Specifications.
Scan Width : 105mm / 4.25 inches

Resolution  Gradation Level
400dpi 64

300dpi 64
2000p1 16

100pi 1
Scan M ting

TEXT Black & White

PHOTO3  Dither - Screen

Power supply specifications

Votage  +12V DC nominal, tolerance +0.8Y, 0.4V
Current  150mA continuous, 750mA max for 3 mins.

cause the scanner output 0 deteriorate.
PSUInput 240 volts
Ouput 12 volt, centre +ve
Hardware Interface Cartridge specifications
Parallel Port Use

Pot VO Scanner Description

00.07 | DATA  D7isleftmostbil
ACK' | STB strobe from scanny
BUSY ON  switch on scanner

L O NEXT strobe o scanner

POUT O STAM  high for stream mode
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APPENDIX B : SCANNER CARE

Cautions on handling your scanner

1

Do not use or leave your scanner in places where it can be
oxposed o et sulgh, dust Ngh humcty, very lowmigh

‘Avoid contact with solvents.

into
the scanner.

ot pull he cable.
Do not use benzine, thinners, or chemical dustcloth.

o clean the scanner case, roler and cable se a cloth
moistened with water and wipe with a softlnt-free cloth.

Tum of power o campuer whn connecting o dacomnecing
from syst

Avoid accidental spilage of drnks, liquids, etc. on scanner.

T s racss mechaniam, lessado ol ghethe it 8 igh
shock, such as a drop o

Staples, clips, etc. must be removed from documents before
Scanning to prevent scratches on scanning window.

% 1991 Pandaal Marketing Ltg




